Agreement

The purchase and use of all Software and Services is subject to the Agreement as defined in Kaseya’s “Click-Accept” EULATOS as updated from time to time by Kaseya at http://www.kaseya.com/legal.aspx. If Customer does not agree with the Agreement, please do not install, use or purchase any Software and Services from Kaseya as continued use of the Software or Services indicates Customer’s acceptance of the Agreement.”
The **Info Center** in **Virtual System Administrator™ v6.3** introduces a new “custom” report builder. Custom reports enable users to customize report templates and report definitions. Existing report definitions are labeled “legacy” reports to distinguish them in the user interface. Enhancements include:

- Elements of a custom report are called "parts". Parts can be re-used to create multiple layouts. Types of parts include: Tables, Bar Charts, Pie Charts and Name Value Parts.
- A Name Value part queries the database and displays the result in a report as a single value next to a single descriptive label or “name”. Useful for creating “counts” in a report.
- Modified custom report definitions can be saved as new report templates.
- An instance of a report part can be saved and reused in multiple report templates and report definitions.
- Custom report templates and report parts can be imported/exported.
- Customizable cover pages, headers and footers can be assigned to any Custom report template or Custom report definition.

This quickstart guide focuses on how to design and publish **Custom Reports**.

### Report Definitions

A report is published from a report definition. Report definitions contain all the *default* settings that determine the content, layout and file format of the published report. You can override these defaults when you run (publish) or schedule the report.

Report definition settings are copied from a report template when the report definition is created. Changing a report definition does not change the report template it was copied from. Changes made to a report template do not affect report definitions already copied from that template.

To create a **custom report definition** based on a **report template**:

1. Click **Info Center > Reporting > Reports > New**.
2. Select the custom **Report** option.
3. Select a **category**, then a **template**, then click **Create**.

   **Note:** A custom report template must be published *(page 2)* for you to see it within a Reports category.

4. Specify options for report definitions using header options and three tabs:
   - **(Header Options)** - Specify the name and report title. You can also require approval for the report.
   - **Layout** - See **Report Templates** *(page 2)* for a description of these options.
     - **Note:** When a legacy report definition is added or edited, a Parameters tab displays instead of the Layout tab.
   - **General** - Sets the type of report output—PDF, HTML or EXCEL—paper size and orientation.
     - **Note:** CSV is available as a report output, but only if the VSA is configured to use SQL Server Reporting Services, instead of the default Kaseya Reporting Services.

The **General** tab also sets the message used to notify users when the report is run. Tokens can be included in report email messages, in both the subject line and the body of the message.
Report Templates

- `<gr>` - machine group
- `<id>` - machine id
- `<rt>` - report name
- `<embd>` - In the message body only, you can embed an HTML report at the specified location.

Use the edit toolbar to add images and special formatting to the text. Images must be uploaded rather than copied and pasted in.

- `` - Hyperlink selected text. You may need to reset links copied and pasted from another source.
- `` - Insert a table.
- `` - Insert a horizontal line as a percentage of the width, or set a fixed width in pixels.
- `` - Indent text.
- `` - Outdent text.
- `` - Remove formatting.
- `` - Insert a symbol.
- `` - Insert an emoticon.
- `` - Preview the display of text and images.
- `` - Upload a file or image.
- `` - Set selected text to subscript.
- `` - Set selected text to superscript.
- `` - Toggle full screen mode for editing and viewing.

- Cover Page, Header, Footer - Selects the cover page, header and footer (page 32) of the report.

Report Templates

Info Center > Configure & Design > Report Templates

The Report Templates page defines customizable report templates. For detailed information see:

- Folder Tree (page 4)
- Add / Edit Report Template (page 5)
- Table (page 7)
- Bar Chart (page 10)
- Pie Chart (page 13)
- Line Chart (page 16)
- Report Image (page 19)
- Custom Text Designer (page 19)
- Name Value Part (page 20)

Terms and Concepts

- Report Definitions - Report definitions contain all the settings that determine the content, layout and file format of a report. A report is published from a report definition (page 1).
- Report Templates - A report definition is created by copying settings from a report template. Report templates define all the default settings for the content, layout and file format of a report definition. There are two types of report templates:
  - `` Custom - Customizable report templates.
- **Legacy** - Fixed layout report templates provided in earlier releases.

- **Data Sets** - Customizable report templates are constructed from *data sets*. A data set is a collection of data, in table format, queried from the Kaseya Server SQL server database. Predefined data sets are listed on the *Report Parts* (page 23) page, organized by VSA module folder. For example, in the Agent module folder, the following data sets are provided:

  - Agent Configuration
  - Agent Portal Access
  - Agent Protection Settings
  - Agent Status

- **Data Columns** - Each dataset is a collection of one or more *data columns*. For example, the *Agent Status* data set lists the following data columns:

  - agentGuid
  - Computer Name
  - Current User
  - Group Name
  - Last Logged On User
  - Machine ID
  - Online
  - Operating System
  - OS Information
  - Reverse Group Name
  - Show Tooltip
  - Timezone Offset
  - Tooltip Notes
  - Transition Time

- **Report Parts** - The content and layout of a report template or report definition is constructed out of *report parts*. When constructing a *report part*, you select the columns of data in a data set you want to display in the report template or report definition. *Each part can only select columns of data from a single data set*. Each report part also determines the display of data in a particular format. There are several types of *report part formats*:

  - **Table** - Displays one or more columns of data in table format returned by a selected data set.
  - **Bar Chart** - Displays a bar chart, based on two columns of data returned by a selected data set.
  - **Pie Chart** - Displays a pie chart, based on two columns of data returned by a selected data set.
  - **Line Chart** - Displays a line chart, based on two columns of data returned by a selected data set.
  - **Report Image** - Displays a selected report image.
  - **Custom Text Designer** - Displays a group of one or more static text and design controls.
  - **Name Value Part** - Displays a single value with a user-defined label, based on a *custom* data set. For example: Open Tickets: 247.

**Report Part Options** - Each report part can be configured using the following options:

  - **Aggregate Options** - Aggregate options return a single *numeric* value calculated from multiple cells in a selected column. For example, the aggregate option COUNT returns the number of non-null values in a selected column. Except for COUNT or COUNT_BIG, aggregate functions ignore null values.
  - **Order by** - Data can be displayed in a preferred order, using combinations of selected columns, aggregate options, and ascending/descending sort orders.
  - **Group by** - Returned rows of data can by organized into subheadings and subgroups by selecting "group by" columns. Multiple levels of "group by" columns are supported. *Applies to table parts only.*
Report Templates

- **Filtering** - The data displayed can be limited by specialized data filters. These include:
  - A specified number of rows or percentage of rows of data.
  - Comparing selected columns with specified values.

- **Custom Fields** - Custom agent fields—created using the Audit > Machine Summary or System Information pages—are supported in views, procedures, legacy reports and in selected Audit category reports parts. Custom reports do not support more than 40 custom fields.

- **Coverpage, Header, Footer** - This page defines presentation elements that are independent of the data displayed in the report. You can use these elements to "brand" your reports by creating a unique look and feel. Assign different combinations of coverpages, headers and footers to multiple custom report templates and custom report definitions.

- **Published / Unpublished** - A published report template can be used to create report definitions. Unpublished report templates are hidden from the list of templates available to create report definitions.

- **Make Template** - A Make Template button in Reports saves a report definition to a selected Report Templates folder. For example, users may create useful enhancements to their own report definitions. These in turn might be worth converting into report templates that other users can use to create report definitions.

- **Reusing Parts** - Any time after a part is configured within a template you can optionally save a part to the Report Parts page. This makes it a "standard" part that can be reused in templates and report definitions. You can also copy a part directly from an existing template into another template, without saving it as a "standard" part.

- **Import / Export** - Both report templates and report parts can be imported and exported using System > Import Center.

Folder Tree

Info Center > Configure & Design > Report Templates

Report templates are organized into a single folder tree in the middle pane underneath a Template cabinet. Use the following options to manage report templates in this folder tree.

**Note:** The categories you see when creating a new report definition are based on the top-level folders in the Report Templates folder tree. By default a top-level folder is created for each installed module.

When the Templates Cabinet is Selected

- **Collapse All** - Collapses all branches of the folder tree.
- **Expand All** - Expands all branches of the folder tree.

When a Folder is Selected

A folder for each installed module has been created for you. You can use these or create your own.

- **Add Folder** - Adds a report template folder with a specified name.
- **Add** - Adds a report template in the selected folder.
- **Share** - Shares a folder with user roles and individual users. See guidelines for share rights to objects within folder trees in the Folder Rights topic.

When a Template is Selected

- **Add** - Adds a new report template in the selected folder.
- **Edit** - Edits a selected report template.
Note: System report templates cannot be edited or deleted but can be copied.

- **Delete** - Deletes a selected report template.
- **Rename** - Renames a selected report template.
- **Publish / Unpublish** - Toggles between these two states. Clicking **Publish** enables a report template to be used to create a report definition (page 1). Clicking **Unpublish** prevents a report template from being used to create a report definition.
- **Copy** - Creates a copy of an existing report template.
- **Preview** - Generates a report for the current user only, based on a selected report template.

### Add / Edit Report Template

Info Center > Configure & Design > Report Templates > Add Report Template / Edit

**Report Design Description**

- **Name** - The name of the report template.
- **Template Title** - The title displayed.

Note: See Report Definitions (page 1) for a description of options on the General tab and Cover Page, Header and Footer tab.

### Layouts tab

In the left hand pane, the **Layouts** tab displays a data object tree of data sets. A two-column table displays in the right hand pane. You can drag-and-drop data sets from the data object tree into any of the cells of the two-column table. A data set can only occupy one or both cells of a single row. A report part displays data returned by a data set in a specific format. There are several types of report part formats:

- **Table** - Displays one or more columns of data in table format returned by a selected data set.
- **Bar Chart** - Displays a bar chart, based on two columns of data returned by a selected data set.
- **Pie Chart** - Displays a pie chart, based on two columns of data returned by a selected data set.
- **Line Chart** - Displays a line chart, based on two columns of data returned by a selected data set.
- **Report Image** - Displays a selected report image.
- **Custom Text Designer** - Displays a group of one or more static text and design controls.
- **Name Value Part** - Displays a single value with a user-defined label, based on a custom data set. For example: Open Tickets: 247.
The data object tree also includes existing templates. You can drag and drop a part from an existing template into the right hand pane, then modify this new copy of the part for your new template. The source template remains unchanged.

Adding a Report Part to a Layout

1. Drag-and-drop a data set from the data object tree in the left hand pane into one of the cells in the right hand pane.
2. Select the report part format. You can not switch formats after you make this selection. You can delete the report part, re-add it, then select a different format.

3. Click the gear icon or double-click the cell to configure the report part. The report template cannot be saved until a report part has been configured at least once. Unconfigured report parts display a red box around their cells.

4. Configuring a report part depends on the type of report part selected. See:
   - **Table** (page 7)
   - **Bar Chart** (page 10)
   - **Pie Chart** (page 13)
   - **Line Chart** (page 16)
   - **Report Image** (page 19)
   - **Custom Text Designer** (page 19)
   - **Name Value Part** (page 20)

5. Use the Resize icon to expand a report part into two cells on a single row or collapse it back to a single cell. *Expanding a report part into multiple rows is not supported.*

6. Any time after a part is configured within a template you can optionally save a part to the Report Parts (page 23) page by clicking the save icon. This makes it a "standard" part that can be used in templates and report definitions.

---

**Table**

Info Center > Configure & Design > Report Templates > Add Report Template / Edit > Gear Icon

A **Table** is configured using a three step wizard:
- Step 1 - Select Columns
- Step 2 - Ordering and Grouping
Step 1 - Select Columns

Format

- **Dataset Name** - The name of the data set associated with this table.
- **Title** - Enter a title for the report part.
- **Title Alignment** - Left, Right, Center
- **Show Title** - If checked, the title displays on the published report with this report part. If blank, the title is hidden.
- **Page Break** - If enabled, forces a page break next to this report part. Options include No Page Break, Before, After, Before and After. A break in either cell, before or after, has precedence over no break in the other cell. An After page break is ignored if a table runs beyond the length of the page in the other cell.
- **Text Size** - Extra Small, Small, Normal, Large.

Columns / Column Selections

Drag-and-drop columns from the Columns list to the Column Selections list.

- **Delete Row** - Removes a selected column from the list.
- **Column** - A column selected for inclusion in the published report.
- **Alias** - Displays as the heading for a selected column, in place of the column name.
- **Aggregate** - Aggregate options return a single numeric value calculated from multiple cells in a selected column. For example, the aggregate option COUNT returns the number of non-null values in a selected column. Except for COUNT or COUNT_BIG, aggregate functions ignore null values.
  - **AVG** - Returns the average of the values in a group. Null values are ignored.
  - **COUNT / COUNT_BIG** - Returns the number of items in a group. COUNT works like the COUNT_BIG function. The only difference between the two functions is their return values. COUNT always returns an int data type value. COUNT_BIG always returns a bigint data type value.
  - **MAX** - Returns the maximum value in a group.
  - **MIN** - Returns the minimum value in a group.
  - **STDEV** - Returns the statistical standard deviation of all values in a group.
  - **STDEVP** - Returns the statistical standard deviation for the population for all values in a group.
  - **SUM** - Returns the sum of all the values in a group. SUM can be used with numeric columns only. Null values are ignored.
  - **VAR** - Returns the statistical variance of all values in a group.
  - **VARP** - Returns the statistical variance for the population for all values in a group.
- **Weight** - Determines the percentage width of each column by assigning a numerical value. For example, if four rows are sequentially weighted with the values 4, 3, 2, 1, then,
  - The first row, with a weight of 4, is 40% of the sum of all weight values, 10.
  - The second row, with a weight of 3, is 30% of the sum of all weight values, 10.
  - The third row, with a weight of 2, is 20% of the sum of all weight values, 10.
  - The fourth row, with a weight of 1, is 10% of the sum of all weight values, 10.

Step 2 - Ordering and Grouping

Order by
Determines the order data is displayed, from first to last. Multiple rows can be configured, with a higher row having precedence over a lower row. A selected order by column does not have to be displayed in the report.

- **Add Row** - Adds an order by row.
- **Delete Row** - Deletes an order by row.
- **Column** - Selects a column used to determine the order data displayed, from first to last.
- **Aggregate** - If an aggregate option is selected, the sort order is applied to the numeric value returned by the aggregate option instead of the selected column. See the description for each aggregation option described above.
- **Sort Order** - Ascending or Descending. Applies to either the selected column or to the aggregate option, if one is specified.

**Group by**

Returned rows of data can by organized into subheadings and subgroups by selecting "group by" columns. Multiple levels of "group by" columns are supported.

- **Add Row** - Adds a group by row.
- **Delete Row** - Deletes a group by row.
- **Column** - The column selected to group returned rows of data.

### Step 3 - Filters

The data displayed can be limited by specialized data filters.

**Note:** Additional filtering options display when a report definition or report template is run or scheduled.

**Row Filter**

- **Limit Type** - The type of row limit specified.
  - **Top N** - Limits data returned to the first N number of rows returned. Example: If the **Limit** is 10, the first 10 rows of 300 rows available are returned. Result: 10 rows are returned.
  - **Top N %** - Limits data returned to the first N % of rows returned. Example: If the **Limit** is 10 the first 10% of 300 available rows are returned. Result: 30 rows are returned.
- **Limit** - The number specified for the **Limit Type** field.
- **Select Distinct** - If checked, duplicate rows are not returned. For all columns displayed in the report, the values in a row must match the values of another row to be considered a duplicate.

**Date Filter**

Date filters only display if date/time columns are included in the report part.

- **Date Filter Column** - Select a date/time column to filter the data queried by this part of the report.
  
  **Note:** You must select a date/time column for the other date filter options below to have any effect.

- **Time Range Type** - Select a time period to filter the data queried for this part of the report.
  - **Predefined Ranges** - This Week, Last Week, This Month, Last Month, This Quarter, Last Quarter.
  - **Inherit from Report** - When you schedule or run a report, **Date Filter** options display on the **Filters** tab and determine the time period used to query data for this part of the report.
  - **Last N Days** - Enter the value of N in the **Number of Days** field.
  - **Fixed Range** - Enter a **Start DateTime** and **End DateTime**.
- **Number of Days** - Enter the value of N in this field if **Last N Days** was selected.
- **Start DateTime** - Select a start date and time if **Fixed Range** was selected.
Report Templates

- **End DateTime** - Select the end date and time if Fixed Range was selected.

**Advanced Filters**

Rows can be limited by comparing selected columns with specified values.

- **Add Row** - Adds a comparison row.
- **Delete Row** - Deletes a comparison row.
- **Field** - Selects a column used to compare with a specified value.
- **Operator** - The operator used to compare a selected column with a specified value.
  - Equal (=) - Enter a comma separated list of values to create an OR statement.
  - Not Equal (!=) - Enter a comma separated list of values to create an OR statement.
  - Like - If a selected column contains this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  - Not Like - If a selected column does not contain this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  - Greater Than (>)
  - Greater Than or Equal (>=)
  - Less Than (<)
  - Less Than or Equal (<=)
  - Between - If the selected column is between two string values, separated by a comma, display this row. Comparison is from left to right. Examples:
    - Number field format - 1000,9999
    - String field format - aaa,zzz
    - Date field format - 01-01-2014,03-31-2014
  - Is Empty - If the selected column does not have characters, display this row.
  - Is Null - If the selected column is null, display this row.
  - Not Empty - If a selected column is not null, display this row.
  - Not Null - If a selected column is not null, display this row.
- **Value** - The specified value.

---

**Bar Chart**

Info Center > Configure & Design > Report Templates > Add Report Template / Edit > Gear Icon

A **Bar Chart** is configured using a two step wizard:

- Step 1 - Layout
- Step 2 - Filtering

**Step 1 - Layout**

**Title**

- **Dataset Name** - The name of the data set associated with this table.
- **Show Title on Report** - If checked, the title displays on the published report with this report part. If blank, the title is hidden.
- **Title** - Enter a title for the report part.
Report Templates

- **Description** - A description of the report part.

**Format**

- **Bar Chart Type** - The orientation and shape of the bars in the chart.
  - Vertical Bar
  - Vertical Cylinder Bar
  - Horizontal Bar
  - Horizontal Cylinder Bar

  **Note:** Horizontal bar charts may require both columns of the report layout to display data correctly.

- **Show Chart in 3D** - If checked, the chart is 3 dimensional. Cylinder bar options must be 3 dimensional.

- **Page Break** - If enabled, forces a page break next to this report part. Options include No Page Break, Before, After, Before and After. A break in either cell, before or after, has precedence over no break in the other cell. An After page break is ignored if a table runs beyond the length of the page in the other cell.

- **Do not show the axis titles** - If checked, axis titles are not displayed.

**Data Properties**

- **Bar Category** - Any column in the data set that you want to display varying numerical data for. For example, you could display a numerical value for each machine group included in the published report.

- **Bar Value** - Any other column in the data set that can be represented numerically. **A value must either be numeric or evaluate to numeric as the result of an aggregation.** If a non-numeric column is selected, you can only use COUNT, or COUNT_BIG as aggregates.

- **Alias** - Displays as the heading for a selected column, in place of the column name.

- **Aggregate** - Aggregate options return a single numeric value calculated from multiple cells in a selected column. For example, the aggregate option COUNT returns the number of non-null values in a selected column. Except for COUNT or COUNT_BIG, aggregate functions ignore null values.
  - AVG - Returns the average of the values in a group. Null values are ignored.
  - COUNT / COUNT_BIG - Returns the number of items in a group. COUNT works like the COUNT_BIG function. The only difference between the two functions is their return values. COUNT always returns an int data type value. COUNT_BIG always returns a bigint data type value.
  - MAX - Returns the maximum value in a group.
  - MIN - Returns the minimum value in a group.
  - STDEV - Returns the statistical standard deviation of all values in a group.
  - STDEVP - Returns the statistical standard deviation for the population for all values in a group.
  - SUM - Returns the sum of all the values in a group. SUM can be used with numeric columns only. Null values are ignored.
  - VAR - Returns the statistical variance of all values in a group.
  - VARP - Returns the statistical variance for the population for all values in a group.

**Order by**

Determines the order data is displayed, from first to last. Multiple rows can be configured, with a higher row having precedence over a lower row. A selected order by column does not have to be displayed in the report.
Report Templates

- **Add Row** - Adds an order by row.
- **Delete Row** - Deletes an order by row.
- **Column** - Selects a column used to determine the order data displayed, from first to last.
- **Aggregate** - If an aggregate option is selected, the sort order is applied to the numeric value returned by the aggregate option instead of the selected column. See the description for each aggregation option described above.
- **Sort Order** - Ascending or Descending. Applies to either the selected column or to the aggregate option, if one is specified.

**Step 2 - Filters**

The data displayed can be limited by specialized data filters.

**Note:** Additional filtering options display when a report definition or report template is run or scheduled.

**Row Filter**

- **Limit Type** - The type of row limit specified.
  - **Top N** - Limits data returned to the first N number of rows returned. Example: If the Limit is 10, the first 10 rows of 300 rows available are returned. Result: 10 rows are returned.
  - **Top N %** - Limits data returned to the first N % of rows returned. Example: If the Limit is 10 the first 10% of 300 available rows are returned. Result: 30 rows are returned.
- **Limit** - The number specified for the Limit Type field.
- **Select Distinct** - If checked, duplicate rows are not returned. For all columns displayed in the report, the values in a row must match the values of another row to be considered a duplicate.

**Date Filter**

Date filters only display if date/time columns are included in the report part.

- **Date Filter Column** - Select a date/time column to filter the data queried by this part of the report.

  **Note:** You must select a date/time column for the other date filter options below to have any effect.

- **Time Range Type** - Select a time period to filter the data queried for this part of the report.
  - **Predefined Ranges** - This Week, Last Week, This Month, Last Month, This Quarter, Last Quarter.
  - **Inherit from Report** - When you schedule or run a report, Date Filter options display on the Filters tab and determine the time period used to query data for this part of the report.
  - **Last N Days** - Enter the value of N in the Number of Days field.
  - **Fixed Range** - Enter a Start DateTime and End DateTime.
- **Number of Days** - Enter the value of N in this field if Last N Days was selected.
- **Start DateTime** - Select a start date and time if Fixed Range was selected.
- **End DateTime** - Select the end date and time if Fixed Range was selected.

**Advanced Filters**

Rows can be limited by comparing selected columns with specified values.

- **Add Row** - Adds a comparison row.
- **Delete Row** - Deletes a comparison row.
- **Field** - Selects a column used to compare with a specified value.
- **Operator** - The operator used to compare a selected column with a specified value.
  - **Equal (=)** Enter a comma separated list of values to create an OR statement.
Report Templates

- Not Equal (!=) Enter a comma separated list of values to create an OR statement.
- Like - If a selected column contains this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
- Not Like - If a selected column does not contain this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
- Greater Than (>)
- Greater Than or Equal (>=)
- Less Than (<)
- Less Than Or Equal (<=)
- Between - If the selected column is between two string values, separated by a comma, display this row. Comparison is from left to right. Examples:
  - Number field format - 1000,9999
  - String field format - aaa,zzz
  - Date field format - 01-01-2014,03-31-2014
- Is Empty - If the selected column does not have characters, display this row.
- Is Null - If the selected column is null, display this row.
- Not Empty - If the selected column has characters, display this row.
- Not Null - If a selected column is not null, display this row.

- Value - The specified value.

Pie Chart

Info Center > Configure & Design > Report Templates > Add Report Template / Edit > Gear Icon

A Pie Chart is configured using a two step wizard:
- Step 1 - Layout
  - Step 1 - Layout
  - Step 2 - Filtering

Step 1 - Layout

Title

- Title - Enter a title for the report part.
- Show Title on Report - If checked, the title displays on the published report with this report part. If blank, the title is hidden.

Format

- Pie Chart Type - The orientation and shape of the pie chart.
  - Standard Pie
  - Exploded Pie
- Show Chart in 3D - If checked, the chart is 3 dimensional.
- Page Break - If enabled, forces a page break next to this report part. Options include No Page Break, Before, After, Before and After. A break in either cell, before or after, has precedence over no break in the other cell. An After page break is ignored if a table runs beyond the length of the page in the other cell.
Report Templates

- **Display Pie Value inside of the Pie Graphic** - If checked, values display inside each wedge of the pie chart. If blank, the values display as callouts around the edge of the pie chart.

**Data Properties**

- **Category** - Any column in the data set that you want to display varying numerical data for. For example, you could display a numerical value for each machine group included in the published report.
- **Value** - Any other column in the data set that can be represented numerically. A value must either be numeric or evaluate to numeric as the result of an aggregation. If a non-numeric column is selected, you can only use COUNT, or COUNT_BIG as aggregates.
- **Alias** - Displays as the heading for a selected column, in place of the column name.
- **Aggregate** - Aggregate options return a single numeric value calculated from multiple cells in a selected column. For example, the aggregate option COUNT returns the number of non-null values in a selected column. Except for COUNT or COUNT_BIG, aggregate functions ignore null values.
  - AVG - Returns the average of the values in a group. Null values are ignored.
  - COUNT / COUNT_BIG - Returns the number of items in a group. COUNT works like the COUNT_BIG function. The only difference between the two functions is their return values. COUNT always returns an int data type value. COUNT_BIG always returns a bigint data type value.
  - MAX - Returns the maximum value in a group.
  - MIN - Returns the minimum value in a group.
  - STDEV - Returns the statistical standard deviation of all values in a group.
  - STDEVP - Returns the statistical standard deviation for the population for all values in a group.
  - SUM - Returns the sum of all the values in a group. SUM can be used with numeric columns only. Null values are ignored.
  - VAR - Returns the statistical variance of all values in a group.
  - VARP - Returns the statistical variance for the population for all values in a group.

**Order by**

Determines the order data is displayed, from first to last. Multiple rows can be configured, with a higher row having precedence over a lower row. A selected order by column does not have be displayed in the report.

- **Add Row** - Adds an order by row.
- **Delete Row** - Deletes an order by row.
- **Column** - Selects a column used to determine the order data displayed, from first to last.
- **Aggregate** - If an aggregate option is selected, the sort order is applied to the numeric value returned by the aggregate option instead of the selected column. See the description for each aggregation option described above.
- **Sort Order** - Ascending or Descending. Applies to either the selected column or to the aggregate option, if one is specified.

**Step 2 - Filters**

The data displayed can be limited by specialized data filters.

*Note: Additional filtering options display when a report definition or report template is run or scheduled.*

**Row Filter**

- **Limit Type** - The type of row limit specified.
Report Templates

- **Top N** - Limits data returned to the first N number of rows returned. Example: If the Limit is 10, the first 10 rows of 300 rows available are returned. Result: 10 rows are returned.
- **Top N %** - Limits data returned to the first N % of rows returned. Example: If the Limit is 10 the first 10% of 300 available rows are returned. Result: 30 rows are returned.
  
  - **Limit** - The number specified for the Limit Type field.
  - **Select Distinct** - If checked, duplicate rows are not returned. For all columns displayed in the report, the values in a row must match the values of another row to be considered a duplicate.

**Date Filter**

Date filters only display if date/time columns are included in the report part.

- **Date Filter Column** - Select a date/time column to filter the data queried by this part of the report.

  
  **Note:** You must select a date/time column for the other date filter options below to have any effect.

- **Time Range Type** - Select a time period to filter the data queried for this part of the report.
  
  - **Predefined Ranges** - This Week, Last Week, This Month, Last Month, This Quarter, Last Quarter.
  
  - **Inherit from Report** - When you schedule or run a report, Date Filter options display on the Filters tab and determine the time period used to query data for this part of the report.
  
  - **Last N Days** - Enter the value of N in the Number of Days field.
  
  - **Fixed Range** - Enter a Start DateTime and End DateTime.

- **Number of Days** - Enter the value of N in this field if Last N Days was selected.
- **Start DateTime** - Select a start date and time if Fixed Range was selected.
- **End DateTime** - Select the end date and time if Fixed Range was selected.

**Advanced Filters**

Rows can be limited by comparing selected columns with specified values.

- **Add Row** - Adds a comparison row.
- **Delete Row** - Deletes a comparison row.
- **Field** - Selects a column used to compare with a specified value.
- **Operator** - The operator used to compare a selected column with a specified value.
  
  - **Equal (=)** Enter a comma separated list of values to create an OR statement.
  
  - **Not Equal (!=)** Enter a comma separated list of values to create an OR statement.
  
  - **Like** - If a selected column contains this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  
  - **Not Like** - If a selected column does not contain this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  
  - **Greater Than (>)**
  
  - **Greater Than or Equal (>=)**
  
  - **Less Than (<)**
  
  - **Less Than Or Equal (<=)**
  
  - **Between** - If the selected column is between two string values, separated by a comma, display this row. Comparison is from left to right. Examples:
    
    - **Number field format** - 1000,9999
    
    - **String field format** - aaa,zzz
    
    - **Date field format** - 01-01-2014,03-31-2014
  
  - **Is Empty** - If the selected column does not have characters, display this row.
Report Templates

- **Is Null** - If the selected column is null, display this row.
- **Not Empty** - If the selected column has characters, display this row.
- **Not Null** - If a selected column is not null, display this row.
  - **Value** - The specified value.

## Line Chart

A line chart is configured using a two step wizard:

### Step 1 - Layout

**Title**
- **Dataset Name** - The name of the data set associated with this table.
- **Show Title on Report** - If checked, the title displays on the published report with this report part. If blank, the title is hidden.
- **Title** - Enter a title for the report part.
- **Description** - A description of the report part.

### Format

- **Line Chart Type**
  - **Standard Line** - Displays straight line segments between data points.
  - **Smooth Line** - Displays curved ‘best fit’ line segments between data points.

**Note:** Horizontal line charts may require both columns of the report layout to display data correctly.

- **Multi Line Chart** - If checked, a separate line is created for each line category included in the chart. If blank, a single line is created that represents the sum of all line values of all line categories included in the chart.
- **Show Chart in 3D** - If checked, the chart is 3 dimensional. Cylinder bar options must be 3 dimensional.
- **Do not show the axis titles** - If checked, axis titles are not displayed.
- **Page Break** - If enabled, forces a page break next to this report part. Options include **No Page Break**, **Before**, **After**, **Before and After**. A break in either cell, before or after, has precedence over no break in the other cell. An **After** page break is ignored if a table runs beyond the length of the page in the other cell.

### Data Properties

- **Line Category** - Any column in the data set that you want to display varying numerical data for. For example, you could display a numerical value for each machine group included in the published report.
- **Line Value** - Any other column in the data set that can be represented numerically. A value must either be numeric or evaluate to numeric as the result of an aggregation. If a non-numeric column is selected, you can only use COUNT, or COUNT_BIG as aggregates.
Report Templates

- **Alias** - Displays as the heading for a selected column, in place of the column name.
- **Aggregate** - Aggregate options return a single *numeric* value calculated from multiple cells in a selected column. For example, the aggregate option COUNT returns the number of non-null values in a selected column. Except for COUNT or COUNT_BIG, aggregate functions ignore null values.
  - AVG - Returns the average of the values in a group. Null values are ignored.
  - COUNT / COUNT_BIG - Returns the number of items in a group. COUNT works like the COUNT_BIG function. The only difference between the two functions is their return values. COUNT always returns an *int* data type value. COUNT_BIG always returns a *bigint* data type value.
  - MAX - Returns the maximum value in a group.
  - MIN - Returns the minimum value in a group.
  - STDEV - Returns the statistical standard deviation of all values in a group.
  - STDEVP - Returns the statistical standard deviation for the population for all values in a group.
  - SUM - Returns the sum of all the values in a group. SUM can be used with numeric columns only. Null values are ignored.
  - VAR - Returns the statistical variance of all values in a group.
  - VARP - Returns the statistical variance for the population for all values in a group.

**Order by**

Determines the order data is displayed, from first to last. Multiple rows can be configured, with a higher row having precedence over a lower row. A selected order by column does not have to be displayed in the report.

- **Add Row** - Adds an order by row.
- **Delete Row** - Deletes an order by row.
- **Column** - Selects a column used to determine the order data displayed, from first to last.
- **Aggregate** - If an aggregate option is selected, the sort order is applied to the numeric value returned by the aggregate option instead of the selected column. See the description for each aggregation option described above.
- **Sort Order** - Ascending or Descending. Applies to either the selected column or to the aggregate option, if one is specified.

**Step 2 - Filters**

The data displayed can be limited by specialized data filters.

*Note: Additional filtering options display when a report definition or report template is run or scheduled.*

**Row Filter**

- **Limit Type** - The type of row limit specified.
  - **Top N** - Limits data returned to the first N number of rows returned. Example: If the Limit is 10, the first 10 rows of 300 rows available are returned. Result: 10 rows are returned.
  - **Top N %** - Limits data returned to the first N % of rows returned. Example: If the Limit is 10 the first 10% of 300 available rows are returned. Result: 30 rows are returned.
- **Limit** - The number specified for the Limit Type field.
- **Select Distinct** - If checked, duplicate rows are not returned. For all columns displayed in the report, the values in a row must match the values of another row to be considered a duplicate.

**Date Filter**

Date filters only display if date/time columns are included in the report part.
**Report Templates**

- **Date Filter Column** - Select a date/time column to filter the data queried by this part of the report.  
  
  **Note:** You must select a date/time column for the other date filter options below to have any effect.  

- **Time Range Type** - Select a time period to filter the data queried for this part of the report.
  - **Predefined Ranges** - This Week, Last Week, This Month, Last Month, This Quarter, Last Quarter.
  - **Inherit from Report** - When you schedule or run a report, Date Filter options display on the Filters tab and determine the time period used to query data for this part of the report.
  - **Last N Days** - Enter the value of N in the Number of Days field.
  - **Fixed Range** - Enter a Start DateTime and End DateTime.

- **Number of Days** - Enter the value of N in this field if Last N Days was selected.
- **Start DateTime** - Select a start date and time if Fixed Range was selected.
- **End DateTime** - Select the end date and time if Fixed Range was selected.

**Advanced Filters**

Rows can be limited by comparing selected columns with specified values.

- **Add Row** - Adds a comparison row.
- **Delete Row** - Deletes a comparison row.
- **Field** - Selects a column used to compare with a specified value.
- **Operator** - The operator used to compare a selected column with a specified value.
  - **Equal (=)** Enter a comma separated list of values to create an OR statement.
  - **Not Equal (!=)** Enter a comma separated list of values to create an OR statement.
  - **Like** - If a selected column contains this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  - **Not Like** - If a selected column does not contain this specified value as a substring, then display this row. Enter a comma separated list of values to create an OR statement.
  - **Greater Than (>)**
  - **Greater Than or Equal (>=)**
  - **Less Than (<)**
  - **Less Than Or Equal (<=)**
  - **Between** - If the selected column is between two *string* values, separated by a comma, display this row. Comparison is from left to right. Examples:
    - Number field format - 1000,9999
    - String field format - aaa,zzz
    - Date field format - 01-01-2014,03-31-2014
  - **Is Empty** - If the selected column does not have characters, display this row.
  - **Is Null** - If the selected column is null, display this row.
  - **Not Empty** - If the selected column has characters, display this row.
  - **Not Null** - If a selected column is not null, display this row.

- **Value** - The specified value.
Report Image

Info Center > Configure & Design > Report Templates > Add Report Template / Edit > Gear Icon

A Report Image specifies a report image to add to a report. Available report images are based on the images uploaded to the VSA using the Info Center > Configure & Design > Report Images (page 33) page.

- **Title** - Enter a title for the report image.
- **Show Title** - If checked, the title displays on the published report with the report image. If blank, the title is hidden.
- **Selected Image** - The image selected for this report image. To select an image, select a row, then click the OK button.
- **Report Images**
  - **Name** - The name of the image.
  - **Type** - The type of image—png, jpg, gif, bmp.
  - **Height** - The height of the image in pixels.
  - **Width** - The width of the image in pixels.
  - **Thumbnail** - A thumbnail of the image.

Custom Text Designer

A Custom Text Designer controls enable you to insert presentation elements above, below, or between other elements of your report or report template.

Custom Text Designer Window

Drag and drop the Custom Text Designer control from the Folder Tree (page 4) in the left hand pane of any report or report template page layout (page 5) into any cell on the right side. Once added, the grid cell displays the following icons:

- ☒ - Configures the grid element. Added controls must be configured to save the element.
- ≈ - Resizes the grid element.
- × - Deletes the grid element.

Add or change the following in the header of the Custom Text Designer window.

- **Name** - The name of the element.
- **Description** - The description of the element.
- **Show Name on Report** - If checked, the name of the element displays on the report.

Custom Text Designer Controls

The Custom Text Designer page layout is similar to the report or report template page layout. It enables you to add and configure one or more of the following controls to a single "grouped" design element.

- **Text Box** - Specifies the text, alignment and format of a text box. Both the Text Box and Text Area controls support the following embedded tags.

```
<rt> = report name
<rd> = report date
<org> = organization filter
<gr> = machine group filter
<id> = machine filter
```

- **Text Area** - Specifies the text, alignment and format of a text area.
- **Horizontal Line** - Specifies the format and color of a horizontal line separating other rows of the grid.
- **Spacer** - Specifies the size of vertical white space separating other rows on the grid.

## Name Value Part

A **name value part** is a type of data object that can be added to a report template or report definition. A name value part displays a single value, along with a user-defined label, based on a custom data set. These custom data sets are defined using the Name Value Parts (page 24) page. For example you might want to create a list of single value counts for ticket status.

<table>
<thead>
<tr>
<th>Name Value Part</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tickets Created Last &lt;N&gt; Days</td>
</tr>
<tr>
<td>Total Tickets Past Due</td>
</tr>
<tr>
<td>Tickets Closed Last &lt;N&gt; Days</td>
</tr>
<tr>
<td>Total Open Tickets</td>
</tr>
</tbody>
</table>

*Note: Creating or editing of name value parts is not supported on the Kaseya Cloud platform. All Cloud-based accounts can use pre-defined name value parts via the Control cabinet when creating a report template or a new custom report.*

### Adding a Name Value Part to a Layout

1. Drag-and-drop a name value part from the folder tree in the left hand pane in to one of the cells in the right hand pane.
2. Click the gear icon ☰ to configure the name value part. The report template cannot be saved until the name value part has been configured at least once. Unconfigured name value parts display a red box around their cells.
3. Drag-and-drop a name value part from the folder tree in the left hand pane into the **Name Value Container** list in the right hand pane. You can drop multiple instances of the same name value part into the same list. For example a **Name Value Container** list can include two instances: Agents Online and Agents Offline.

You can optionally edit an instance. Let's assume you want to change the Agents Offline instance to Agents All.

4. Select the row of the instance you want to edit in the **Name Value Container** list.

5. Click **Edit**. Any changes you make only applies to this instance in the report template or report definition you are editing.

   - **Name** - The name displayed by this **Name Value Instance** in configuration dialogs.
   - **Name Label** - The label displayed in the report with its corresponding value.
   - **Parameters** - One or more parameters that determine the value returned for this name value part when a report is published. The values a parameter can have are determined by the query or stored procedure specified using the **Name Value Parts** (page 24) page.
Note: Hover the cursor over each parameter’s name to see a tooltip description of the acceptable values for that parameter.

Report Parts

Info Center > Configure & Design > Report Parts

The Report Parts page lists all pre-defined data sets used in custom reports. This page also enables you to configure report parts outside of a report template or report definition. Report parts defined using this page provide default "standard" configurations for report parts added to report templates and report definitions.

Note: See Report Templates (page 2) for a list of terms and concepts used in this topic.

Custom Fields

Custom agent fields—created using the Audit > Machine Summary or System Information pages—are supported in views, procedures, legacy reports and in selected Audit category reports parts. Custom reports do not support more than 40 custom fields.

Folder Tree

Each module folder in the folder tree lists one or more data sets appropriate to that module. Click any data set in the folder tree to see the columns and column descriptions included in that data set. Clicking an existing report part displays its current configuration in table format in the right hand pane.

When the Cabinet is Selected

- **Collapse All** - Collapses all branches of the folder tree.
- **Expand All** - Expands all branches of the folder tree.

When a Folder is Selected

- No actions are available.

When a Data Set is Selected
Name Value Parts

- New - Creates a report part, based on a selected data set.
  - Table - Adds a Table (page 7) report part.
  - Bar Chart - Adds a Bar Chart (page 10) report part.
  - Pie Chart - Adds a Pie Chart (page 13) report part.

When a Report Part is Selected

- New - Creates a report part, based on a selected data set.
  - Table - Adds a Table (page 7) report part.
  - Bar Chart - Adds a Bar Chart (page 10) report part.
  - Pie Chart - Adds a Pie Chart (page 13) report part.
- Edit - Edits a selected report part.
- Delete - Deletes a selected report part.
- Rename - Renames a selected report part.
- Preview - Generates a preview of the report part.

Name Value Parts

Info Center > Configure & Design > Name Value Parts

The Name Value Parts page creates a custom data set that returns a single value from the SQL database at the time a report is published. The value is displayed with a user-defined, descriptive name on a report. For example, a name value part called OnlineAgents could return a single number: a count of all online agents that match the filtering selected for the report. For detailed information see:

- Folder Tree (page 25)
- Add / Edit Data Set (page 25)
- Well Known Parameters (page 27)
- Report Contexts (page 30)
- Name Value Instances (page 32)

Note: Creating or editing of name value parts is not supported on the Kaseya Cloud platform. All Cloud-based accounts can use pre-defined name value parts via the Control cabinet when creating a report template or a new custom report.

Terms and Concepts

- Name Value Control - Name value parts are added to a Name Value Part (page 20) cabinet on the Report Templates page. Each Name Value Control in a report template can display a set of Name Value Parts in row or column format. For example, you could create a Ticket Status section of the report that shows a series of counts, one for each of the following "names":
  - Tickets Created Last <N> Days
  - Total Tickets Past Due
  - Tickets Closed Last <N> Days
  - Total Open Tickets

- Parameters - Each name value part can be passed a number of parameters. Parameters must have default arguments. The argument of a user-defined parameter is entered or confirmed by the user when the report is published.

- Well Known Parameters - Certain parameters are already "well known" to the system and do not have be defined by the user or provided an argument when the report is published. See Well Known Parameters (page 27).
Name Value Parts

- **Name Value Instance** - An instance stores the arguments assigned to user-defined parameters of a custom data set. These name value instances can be added to a name value control, bypassing the need to enter arguments manually each time a report template is created.

---

**Folder Tree**

**Info Center > Configure & Design > Name Value Parts**

Name value parts are organized into a single folder tree in the middle pane underneath a Name Value Parts cabinet. Use the following options to manage name value parts in this folder tree.

**When the Name Value Parts Cabinet is Selected**

- **Collapse All** - Collapses all branches of the folder tree.
- **Expand All** - Expands all branches of the folder tree.

**When a Folder is Selected**

A folder for each installed module has been created for you. You can use these or create your own.

- **New Data Set** - Adds (page 25) a custom data set in the selected folder.

**When a Data Set is Selected**

- **Edit Data Set** - Edits (page 25) a selected custom data set.
- **Add Name Value Instance** - Adds a name value instance in the selected folder.
- **Delete** - Deletes a custom data set.

**When a Name Value Instance is Selected**

- **Edit** - Edits a name value instance.
- **Delete** - Deletes a name value instance.

---

**Add / Edit Data Set**

**Info Center > Configure & Design > Name Value Parts > New Data Set or Edit Data Set**

The *New Data Set* or *Edit Data Set* window specifies the custom data set used to return a single value from a SQL database. The custom data set uses either a SQL select statement or a stored procedure to return data. The value in a selected column, returned by the first row of data, is the value displayed in the report.

**Action**

- **Create Registration File** - Once you have added or edited a name value part using this dialog:
  1. Click **Create Registration File**. A link to a generated data set XML displays on the subsequent dialog page.
  2. Download the data set XML and place it in the following location:
     \<KServerInstallDirectory>\Xml\Reporting\Custom\DataSetRegistration\1
  3. Click the **System > Server Management > Configure > Change Reporting Configuration > Run Registration** button to register the new or modified data part XML with your VSA.

**Properties**

- **Name** - The name of the custom data set.
- **Description** - A longer description of the custom data set.
Name Value Parts

- **Category** - The Name Value Parts folder, typically corresponding to a module, that a custom data set is located in.

SQL Definition

- **Return Column** - The data column in the SQL select statement that contains the value that will be used in the published report. The value in the first row of data returned is used.
- **Caption** - The caption displayed with the value on the published report.
- **Data Type** - The data type returned. This data type must be compatible with the data type of the data column in the SQL select statement.
  - STRING
  - INT
  - DECIMAL
  - DATE
  - BOOLEAN
- **Context** - Determines the type of filter displayed just before a report is generated. The context should be compatible with the data returned by the SQL definition. For example, if the data returned by the SQL definition supports filtering primarily by agent machines, then the selected context should be MachineFilter.
  - MachineFilter
  - ServiceDeskFilter
  - AssetsFilter
  - DevicesFilter
  - MobileDevicesFilter
  - TicketingFilter
- **Text** - A SQL select statement that returns one or more columns of data. Only the first row of data returned by the SQL select statement is used.
- **Stored Procedure** - The name of a stored procedure and any user defined parameters. Only the first row of data returned by the stored procedure is used.

Parameters

User-defined parameters specified by a SQL select statement or stored procedure must be registered here. This enables report templates and name value parts to display these parameters in configuration dialogs.

Actions

- **Add Row** - Adds a parameter row.
- **Delete Row** - Deletes a selected parameter row.

Columns

- **Param Name** - The name of the parameter.
- **Param Value** - The default value for the parameter.
- **Param Type** - The data type of the parameter.
  - STRING
  - INT
  - DECIMAL
  - DATE
  - BOOLEAN
- **Size** - The size of the parameter.
- **Description** - Enter a description of the acceptable values supported by this parameter. When selecting a different value for a parameter, users can reference this description by hovering the cursor over a parameter's name to display its tooltip.

### Well Known Parameters

When creating name value parts, you can include **Well Known** parameters in your queries. You insert these in SQL queries using the format `@<wellknownname>`. You must also add them to the parameters table. The following are the well known values you can use:

- **@LogoURL** - The URL to the logo used on the report.
- **@ViewID** - The ID for the view selected when the report was created, or -1.
- **@AdminID** - The ID of the VSA user running the report.
- **@CompanyName** - The organization name set for MyOrg.
- **@EffectiveDate** - The date the report is run, adjusted for time zone.
- **@PartitionID** - The ID of the partition running the report.
- **@ReportDate** - The date the report is run, adjusted for time zone.
- **@ReportTitle** - The title of the report as set when the report was created.
- **@ScopeID** - The ID of the scope the report is run under.
- **@RoleID** - The ID of the role the report is run under.
- **@ReportSessionId** - The ID used for a run of a report. It is used to JOIN to a selected context table. You must choose a context from the drop-down when using `@ReportSessionId`.
- **@LangID** - The ID of the language used for the report.
- **@StartDateDateTime** – A special date parameter, that when used in conjunction with `@EndDateDateTime` lets you set the date range at report run time.
- **@EndDateDateTime** - A special date parameter, that when used in conjunction with `@StartDateDateTime` lets you set the date range at report run time.

### ReportSessionID

If you are using a context, then include a `@ReportSessionId` parameter as the value for one of the parameters.

### Examples

Here are some examples of how to make name value parts using well known parameters.
1. This name value part uses @CompanyName to return the company name.
2. This name value part uses @PartitionID to return the machine with the lowest disk space in the partition ID.
3. This name value part uses the \texttt{@ReportSessionID} parameter to return a count of the number of agent procedures run. The MachineFilter context (page 30) enables you to choose filters when the report is run. The parameters \texttt{@StartDateTime} and \texttt{@EndDateTime} let you pick a date range at run time.

**Report Contexts**

You can use \textit{report contexts} to apply filters to your data sets when a report definition is run or when a report part or report template is previewed. Each context provides a different filter. A filter fills a temporary table with a list of items you can JOIN to, which then limits what your query returns.

The following table lists available report contexts, the temporary table used by each context, and the column to JOIN on.

<table>
<thead>
<tr>
<th>Name</th>
<th>TableName</th>
<th>Column</th>
</tr>
</thead>
<tbody>
<tr>
<td>ServiceDeskFilter</td>
<td>ReportCenter.IncidentsFilterList</td>
<td>IncidentId</td>
</tr>
<tr>
<td>AssetsFilter</td>
<td>ReportCenter.AssetsFilterList</td>
<td>AssetId</td>
</tr>
</tbody>
</table>
Your query should both JOIN to one of the table columns above and include a WHERE statement using the Well Known Parameters (page 27) \(@ReportSessionId\) parameter. This ensures you get the data for the current run of the report.

**Example**

The following example uses the MachineFilter context.

```
SELECT COUNT(u.agentGuid) AS agentCount
FROM dbo.users u
INNER JOIN ReportCenter.MachineFilterList mfl ON mfl.AgentGuid = u.agentGuid
WHERE mfl.ReportSessionId = @ReportSessionId AND u.firstCheckin IS NOT NULL
```

Here is how you enter it in the name value part edit dialog.
Name Value Instances

Info Center > Configure & Design > Name Value Parts

A Name Value Instance stores the arguments assigned to user-defined parameters (page 25) of a custom data set. These name value instances can be added to a Name Value Part (page 20), bypassing the need to enter arguments manually each time a report template is created.

Fields

- **Name** - The name of the custom data set.
- **Value Label** - The label displayed with the returned value of the custom data set.

Parameters

These are the arguments for each parameter that are stored with an instance of the custom data set.

Cover Page, Header, Footer

Info Center > Configure & Design > Coverpage, Header, Footer

The Coverpage, Header, Footer page defines presentation elements that are independent of the data displayed in the report. You can use these elements to "brand" your reports by creating a unique look and feel. Assign different combinations of coverpages, headers and footers to multiple custom report templates and custom report definitions.

Tabs

Each type of element is defined using a separate tab.

- **Cover Page**
- **Header**
- **Footer**

Actions

Each element tab displays the same set of buttons.

- **Add / Edit** - Displays the element designer window.
- **Delete** - Deletes the element.
- **Default** - Sets this element as the default.
- **Preview** - Generates a preview of the element.

Element Designer Window

Once the element designer window opens, drag and drop any control into any of cells on the right side of the page to add it to the element's page layout. Once added, the grid cell displays the following icons:

- 🛠 - Configures the grid element. Added controls must be configured to save the element.
- 📐 - Resizes the grid element.
- ✖️ - Deletes the grid element.

Add or change the following in the header of the element designer window.

- **Name** - The name of the element.
- **Description** - The description of the element.
- **Default** - If checked, this element serves as the default when a report template is created.

Controls in the Cover Page, Header and Footer Tabs
Report Images

- **Report Logo** - Sets the width, height and alignment of the report logo.

  Note: By default, VSA report headers display the image specified by the System > Site Customization > Site Header. Changing the value in the System > Configure > Change Reporting Config... > Logo field overrides this default, changing the URL for report headers only. Changing the URL in the Change Reporting Config... > Logo field does not affect the display of the Site Header image.

- **Text Box** - Specifies the text, alignment and format of a text box. Both the Text Box and Text Area controls support the following embedded tags.
  
  <rt> = report name
  <rd> = report date
  <org> = organization filter
  <gr> = machine group filter
  <id> = machine filter

- **Text Area** - Specifies the text, alignment and format of a text area.
- **Filter Table** - Includes a cover legend describing the filtering applied to the report.
- **Horizontal Line** - Specifies the format and color of a horizontal line separating other rows of the grid.
- **Spacer** - Specifies the size of vertical white space separating other rows on the grid.

Controls in the Header and Footer Tabs Only

- **Page #** - Specifies the text, alignment and format of a page number.

---

**Report Images**

Info Center > Configure & Design > Report Images

The Remote Images page enables you to upload and store images—png, jpg, gif, bmp—that can be added to reports and report templates by dragging and dropping a Report Image (page 19) control from the data object tree (page 5) > Controls cabinet.

**Actions**

- **Add** - Uploads and stores an image. The maximum report image file size that you can upload is 1 MB.
- **Delete** - Deletes a selected image.

**Table Columns**

- **Name** - The name of the image.
- **Created** - The date/time the image was created.
- **Last Modified** - The date/time the image was last modified.
- **Type** - The type of image—png, jpg, gif, bmp.
- **Height** - The height of the image in pixels.
- **Width** - The width of the image in pixels.
- **Thumbnail** - A thumbnail of the image.
Defaults

The **Defaults** page sets defaults for report definitions. Defaults include:

- Default Paper Size
- Default Distribution
Index

A
Add / Edit Data Set • 25
Add / Edit Report Template • 5

B
Bar Chart • 10

C
Cover Page, Header, Footer • 32
Custom Text Designer • 19

D
Defaults • 34

F
Folder Tree • 4, 25

I
Introduction • 1

L
Line Chart • 16

N
Name Value Instances • 32
Name Value Part • 20
Name Value Parts • 24

P
Pie Chart • 13

R
Report Contexts • 30
Report Definitions • 1
Report Image • 19
Report Images • 33
Report Parts • 23
Report Templates • 2

T
Table • 7

W
Well Known Parameters • 27